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PR electronics A/S tilbyder et bredt program af analoge og digitale 
signalbehandlingsmoduler til industriel automation. Programmet 
består af Isolatorer, Displays, Ex-barrierer, Temperaturtransmittere, 
Universaltransmittere mfl. Vi har modulerne, du kan stole på i selv 
barske miljøer med elektrisk støj, vibrationer og temperaturudsving, 
og alle produkter opfylder de strengeste internationale standarder. 
Vores motto »Signals the Best« er indbegrebet af denne filosofi – 
og din garanti for kvalitet.

PR electronics A/S offers a wide range of analogue and digital 
signal conditioning modules for industrial automation. The product 
range includes Isolators, Displays, Ex Interfaces, Temperature 
Transmitters, and Universal Modules. You can trust our products 
in the most extreme environments with electrical noise, vibrations 
and temperature fluctuations, and all products comply with the 
most exacting international standards. »Signals the Best« is the 
epitome of our philosophy – and your guarantee for quality.

PR electronics A/S offre une large gamme de produits pour le 
traitement des signaux analogiques et numériques dans tous 
les domaines industriels. La gamme de produits s’étend des 
transmetteurs de température aux afficheurs, des isolateurs aux 
interfaces SI, jusqu’aux modules universels. Vous pouvez compter 
sur nos produits même dans les conditions d’utilisation sévères, 
p.ex. bruit électrique, vibrations et fluctuations de température. 
Tous nos produits sont conformes aux normes internationales les 
plus strictes. Notre devise »SIGNALS the BEST« c’est notre ligne 
de conduite - et pour vous l’assurance de la meilleure qualité.

PR electronics A/S verfügt über ein breites Produktprogramm 
an analogen und digitalen Signalverarbeitungsmodule für die in
dustrielle Automatisierung. Dieses Programm umfasst Displays, 
Temperaturtransmitter, Ex- und galvanische Signaltrenner, und 
Universalgeräte. Sie können unsere Geräte auch unter extremen 
Einsatzbedingungen wie elektrisches Rauschen, Erschütterungen 
und Temperaturschwingungen vertrauen, und alle Produkte von 
PR electronics werden in Übereinstimmung mit den strengsten 
internationalen Normen produziert. »Signals the Best« ist Ihre 
Garantie für Qualität!
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EF-overensstemmelseserklæring
Som producent erklærer

PR electronics A/S 

Lerbakken 10 

DK-8410 Rønde

hermed at følgende produkt:

Type: 5343 

Navn: 2-tråds niveautransmitter

er i overensstemmelse med følgende direktiver og standarder:

EMC-direktivet 2004/108/EF og senere tilføjelser

EN 61326-1 : 2006

For specifikation af det acceptable EMC-niveau henvises til modulets elektriske 
specifikationer.

ATEX-direktivet 94/9/EF og senere tilføjelser

EN 60079-0 : 2006, EN 60079-11 : 2007, 

EN 60079-15 : 2005 og EN 60079-26 : 2007 

EN 61241-0 : 2006 og EN 61241-11 : 2006 

ATEX-certifikat: KEMA 10ATEX0004 X (5343A)

ATEX-certifikat: KEMA 03ATEX1538 (5343B)

Bemyndiget organ 

KEMA Quality B.V. (0344) 

Utrechtseweg 310, 6812 AR Arnhem 

P.O. Box 5185, 6802 ED Arnhem 

The Netherlands

Rønde, 24. marts 2010 Kim Rasmussen 
 Producentens underskrift
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2-TRÅDS NIVEAUTRANSMITTER 
PRelevel 5343

• Indgang for potentiometer eller Ohm 
• Programmerbar følerfejlsværdi 
• Høj målenøjagtighed 
• Unik proceskalibreringsfunktion 
• Programmerbar via PC

Anvendelse

•	 Konvertering af modstandsændringer til standard analogt strømsignal f.eks. 
fra Ohmske niveaustave eller potentiometre i ventildrev.

•	 Brugerdefineret lineariseringsfunktion kan aktiveres.

Teknisk karakteristik

•	 PR5343 kan af brugeren i løbet af få sekunder programmeres til at måle inden 
for de opgivne Ohmske værdier.

•	 Der er løbende sikkerhedscheck af gemte data.

•	 Modulet er beskyttet mod tilslutning af forkert forsyningspolaritet.

•	 PR5343 konfigureres til den aktuelle opgave ved hjælp af en PC, PRelevel-
softwaren og kommunikationsinterfacet Loop Link.

•	 PRelevel-konfigurationsværktøjet, der er en del af PReset-softwaren, er spe-
cielt designet til konfigurering af niveau-applikationer. Blandt andet findes der 
en funktion til ”on line” måling af indgangsspan samt lineariseringsfunktion til 
volumenlineær udgang fra vandretliggende cylindriske tanke.

Montage / installation

•	 Kan monteres i DIN form B følerhoved. I ikke-eksplosionsfarlige områder kan 
5343 monteres på en DIN-skinne med et specielt beslag.

•	 NB: Som Ex-barriere for 5343B anbefaler vi 5104B, 5114B eller 5116B.
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Applikationer
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Elektriske specifikationer
Specifikationsområde:
-40°C til +85°C
Fælles specifikationer:
Forsyningsspænding, DC
	 Standard.................................................. 8,0...35 V
	 ATEX-Ex................................................... 8,0...30 V
Egetforbrug.................................................. 25 mW...0,8 W
Spændingsdrop............................................ 8 VDC
Opvarmningstid............................................ 5 min.
Kommunikationsinterface............................. Loop Link
Signal- / støjforhold...................................... Min. 60 dB 
Reaktionstid (programmerbar)..................... 0,33...60 s
Signaldynamik, indgang............................... 19 bit
Signaldynamik, udgang................................ 16 bit
Kalibreringstemperatur................................. 20...28°C
Nøjagtighed, størst af generelle og basisværdier: 

Generelle værdier

 
Indgangstype

Absolut 
nøjagtighed

Temperatur- 
koefficient

Lin. R ≤ ±0,1% af span ≤ ±0,01% af span / °C 

EMC-immunitetspåvirkning............................. < ±0,5% af span

Basisværdier

 
Indgangstype

Basis- 
nøjagtighed

Temperatur- 
koefficient

Lin. R ≤ ±0,05 Ω ≤ ±0,002 Ω / °C

Bestillingsskema: 5343

Type Version

5343 Standard	 : A 
ATEX Ex	 : B 
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Virkning af forsyningsspændings- 
ændring........................................................ < 0,005% af span / VDC
Vibration....................................................... IEC 60068-2-6 Test FC
Lloyd’s specifikation nr. 1............................. 4 g / 2...100 Hz
Max. ledningskvadrat................................... 1 x 1,5 mm2 flerkoret ledning
Luftfugtighed................................................ < 95% RH (ikke kond.)
Mål................................................................ Ø 44 x 20,2 mm
Kapslingsklasse (hus / klemme)................... IP68 / IP00
Vægt............................................................. 50 g

Elektriske specifikationer, indgang:

Lineær modstandsindgang:
Måleområde................................................. 0...100 kΩ
Min. måleområde (span)............................... 1 kΩ
Max. nulpunktsforskydning (offset).............. 50% af valgt max. værdi
Kabelmodstand pr. leder (max.)................... 100 Ω
Følerstrøm.................................................... > 25 µA, < 120 µA
Virkning af følerkabelmodstand  
(3-leder)........................................................ < 0,002 Ω / Ω
Følerfejlsdetektering..................................... ja

Udgang:

Strømudgang:
Signalområde............................................... 4...20 mA
Min. signalområde........................................ 16 mA
Opdateringstid.............................................. 135 ms
Belastningsmodstand................................... < (Vforsyn.- 8) / 0,023 [Ω]
Belastningsstabilitet..................................... < ±0,01% af span/100 Ω

Følerfejlsdetektering:
Programmerbar............................................ 3,5...23 mA
NAMUR NE43 Upscale................................ 23 mA
NAMUR NE43 Downscale............................ 3,5 mA

Af span = Af det aktuelt valgte område
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Ex-godkendelse - 5343A:
KEMA 10ATEX0004 X...................................  II 3 GD Ex nA [nL] IIC T4...T6 eller
  II 3 GD Ex nL IIC T4...T6 eller
  II 3 GD Ex nA [ic] IIC T4...T6 eller
  II 3 GD Ex ic IIC T4...T6
	 ATEX Installation Drawing No.................. 5343QA02

Ex- / I.S.-godkendelse - 5343B:
KEMA 03ATEX1538......................................  II 1 G Ex ia IIC T4 eller T6
  II 1 D Ex iaD
Max. omgivelsestemp. for T4....................... 85°C
Max. omgivelsestemp. for T6....................... 60°C
ATEX, må anvendes i zone........................... 0, 1, 2, 20, 21 eller 22
	 ATEX Installation Drawing No.................. 5343QA01

Marine-godkendelse:
Det Norske Veritas, Ships & Offshore.......... Standard for Certification No. 2.4
GOST R godkendelse:
VNIIM & VNIIFTRI, Cert. no.......................... Se www.prelectronics.dk
Overholdte myndighedskrav: Standard:
EMC 2004/108/EF........................................ EN 61326-1
ATEX 94/9/EF............................................... EN 60079-0, EN 60079-11, 
	 EN 60079-15 og EN 60079-26 
	 EN 61241-0 og EN 61241-11
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Tilslutninger

1 2 

m A - + 

3 4 6 3 4 6 3 4 6 

Potentiometer, 
3-leder 

2-Trådsinstallation 

Udgang: 

Indgang: 
Modstand, 2-leder Modstand, 3-leder 
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Blokdiagram
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Programmering
•	 Loop Link er et batteridrevet kommunikationsinterface, der er nødvendigt for 

programmering af PRelevel 5343.

•	 Ved programmering henvises til tegningen nedenfor og hjælpefunktionen i  
PRelevel-programmet.

•	 Loop Link må ikke benyttes til kommunkation med moduler installeret i Ex-
område.

Bestilling: Loop Link

Mekaniske specifikationer	M ontering af følerledninger

1 

2 

*

*

Loop
Link

5909 - USB
5905 - RS232

File  Product  Input  Output  Communication  Language  Option  08:30:00

PRetop 5331

Date: 2004-8-10

043201594

PRelectronics

Analog input
Analog output

Serial no:

Input type:
Output type: 4 - 20mA

Upscale
Sensor error:

Pt100  DIN/IEC

0.00 - 50.00 C

3-wire

1.00 sec
------

Input range:

Connection:

Cold junction comp:

Response time:

Tag no:

PRetop 5343 

Modtagende 

udstyr Afbryd 

Stikfor- 
bindelse 

+Vforsyning 

Sort 

Rød Gul 

Grøn 

Indgang 

* Kun forbundet ved 
   on-line programmering 

Loop Link 

COM 

Ledninger monteres mellem metalpladerne
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Konfigurering af potentiometerindgang
På en Ohmsk niveaustav ændres modstandsværdien ved en magnetisk flyders 

aktivering af stavens kontakter. Det betyder, at det oftest er umuligt at benytte 
hele niveaustaven som indgangsspan. Når 5343 benyttes med potentiometer-
indgang, findes der i PRelevel-softwaren følgende specialfunktioner til konfi-
gurering:

[Calibration Password] er 4711. Dette password bør indtastes ved program-
start. De eneste parametre, der kan ændres uden passwordet, er Input 
Low og High for potentiometerindgang. Menupunktet findes under Tools > 
Options. Vær opmærksom på teksten i ’Information’ vinduet under trans-
mittering. Når opsætningen ikke sendes på grund af manglende password, 
afsluttes der med teksten: ’Operation aborted.’ ’Configuration NOT trans-
mitted to the device.’

Beskrivelsen af opsætning med potentiometerindgang tager udgangspunkt i 
skitse 1. Vær opmærksom på, at PRelevel-softwaren kun findes i engelsk-
sproget udgave. Derfor er menuteksterne skrevet, som de ses på skærmen. 
Vælg fanebladet [Input]:

Skitse 1, snit i vandretliggende cylindrisk tank
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[Electrical Calibration] Her indtastes eller PRelevel måler det område på det 
tilsluttede potentiometer, som skal eller kan detekteres. Transmitteren skal 
være tilsluttet kommunikationsinterfacet Loop Link, for at værdierne kan 
måles. Værdierne på skitse 1 er Low = 3% og High = 97%.

[Placement Calibration] Her indtastes placeringen af ’Electrical Calibration’ 
Low og High punkterne på niveaustaven i forhold til tankens højde. Disse 
værdier bruges dels til beregning af lineariseringsværdier og dels til kalkulation 
af 0 og 100% højde. 
Værdierne på skitse 1 er Low = 9% og High = 94%.

[Input] Her indtastes det ønskede inputspan i forhold til højden. Når input 
Low og High er valgt til 0 og 100%, kan indgangen aldrig komme under 
9% og over 94% på grund af niveaustavens udformning og montering. Hvis 
udgangsspannet er 4...20 mA, vil udgangen kun variere fra 5,44...19,04 mA. 
Værdierne på skitse 1 er Low = 0% og High = 100%.

Aktivering af indbyggede lineariseringer
PRelevel-softwaren har indbyggede lineariseringsfunktioner for vandretliggende 

cylindrisk tank og kugletank. Lineariseingsfunktionerne kan aktiveres på føl-
gende måde:

Custom indgangstype: For at få adgang til kundebestemt linearisering skal val-
get i [General Type] indgangsfeltet ende med teksten ’Custom’ og [Calibra-
tion Password] 4711 være indtastet. 

Aktivering af linearisering: I PRelevel 5343 vinduet vælges fanebladet 
[Options]. Hvis en af de indbyggede lineariseringer ønskes anvendt, skal 
der i ’Linearisation’ vinduet vælges "Polynomial.....(Relative)’ for at hente de 
mest nøjagtige lineariseringsfiler. Filerne hentes via følgende menuer >Specify 
+ i hovedmenuen vælg >File > Open + i fildialogen angive >Filnavn >Åben. 

Kundebestemt linearisering: Det er muligt at indtaste egne lineariseringstabel-
ler i menuen >Specify. 
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2-wire level transmitter 

PRelevel 5343
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EC declaration of conformity
As manufacturer

PR electronics A/S 

Lerbakken 10 

DK-8410 Rønde

hereby declares that the following product:

Type: 5343 

Name: 2-wire level transmitter

is in conformity with the following directives and standards:

The EMC Directive 2004/108/EC and later amendments

EN 61326-1 : 2006

For specification of the acceptable EMC performance level, refer to the 
electrical specifications for the module.

The ATEX Directive 94/9/EC and later amendments

EN 60079-0 : 2006, EN 60079-11 : 2007, 

EN 60079-15 : 2005 and EN 60079-26 : 2007 

EN 61241-0 : 2006 and EN 61241-11 : 2006

ATEX certificate: KEMA 10ATEX0004 X (5343A) 

ATEX certificate: KEMA 03ATEX1538 (5343B)

Notified body

KEMA Quality B.V. (0344) 

Utrechtseweg 310, 6812 AR Arnhem 

P.O. Box 5185, 6802 ED Arnhem 

The Netherlands

Rønde, 24 March 2010 Kim Rasmussen 
 Manufacturer’s signature
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2-WIRE LEVEL TRANSMITTER 
PRelevel 5343

• Potentiometer or Ohmic input 
• Programmable sensor error value 
• High measurement accuracy 
• Unique process calibration function 
• Programmable via standard PC

Application

•	 Conversion of resistance variation to standard analogue current signals, e.g. 
from Ohmic level sensors or valve positions.

•	 User-defined linearisation function can be activated.

Technical characteristics

•	 Within a few seconds the user can program PR5343 to measure within the 
defined Ohmic values.

•	 Continuous check of vital stored data for safety reasons.

•	 The transmitter is protected against polarity reversal.

•	 PR5343 is configured to the current task by way of a PC, the PRelevel 
software and the communications interface Loop Link.

•	 The PRelevel configuration tool included in the PReset software has been 
developed specifically for the configuration of level applications. Among other 
things, it contains a function for ”on line” measurement of input span as well 
as a linearisation function for volume linear output from horizontal cylindrical 
tanks.

Mounting / installation

•	 For DIN form B sensor head mounting. In non-hazardous areas the 5343 can 
be mounted on a DIN rail with a special fitting.

•	 NB: As Ex barrier for 5343B we recommend 5104B, 5114B or 5116B.
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Applications
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Electrical specifications
Specifications range:
-40°C to +85°C
Common specifications:
Supply voltage, DC
	 Standard.................................................. 8.0...35 V
	 ATEX Ex.................................................... 8.0...30 V
Internal consumption................................... 25 mW...0.8 W
Voltage drop................................................. 8 VDC
Warm-up time............................................... 5 min.
Communications interface........................... Loop Link
Signal / noise ratio....................................... Min. 60 dB 
Response time (programmable)................... 0.33...60 s
Signal dynamics, input................................. 19 bit
Signal dynamics, output.............................. 16 bit
Calibration temperature............................... 20...28°C
Accuracy, the greater of the general and basic values: 

General values

 
Input type

Absolute 
accuracy

Temperature 
coefficient

Lin. R ≤ ±0.1% of span ≤ ±0.01% of span / °C 

EMC immunity influence................................. < ±0.5% of span

Basic values

 
Input type

Basic 
accuracy

Temperature 
coefficient

Lin. R ≤ ±0.05 Ω ≤ ±0.002 Ω / °C

Order: 5343

Type Version

5343 Standard	 : A 
ATEX Ex	 : B 
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Effect of supply voltage change.................. < 0.005% of span / VDC
Vibration....................................................... IEC 60068-2-6 Test FC
Lloyd’s specification no. 1........................... 4 g / 2...100 Hz
Max. wire size............................................... 1 x 1.5 mm2 stranded wire
Humidity....................................................... < 95% RH (non cond.)
Dimensions................................................... Ø 44 x 20.2 mm
Protection degree (enclosure / terminal)...... IP68 / IP00
Weight.......................................................... 50 g

Electrical specifications, input:

Linear resistance input:
Measurement range..................................... 0...100 kΩ
Min. measurement range (span).................. 1 kΩ
Max. offset................................................... 50% of selected max. value
Cable resistance per wire (max.).................. 100 Ω
Sensor current.............................................. > 25 µA, < 120 µA
Effect of sensor cable resistance 
(3-wire).......................................................... < 0.002 Ω / Ω
Sensor error detection................................. Yes

Output:

Current output:
Signal range................................................. 4...20 mA
Min. signal range.......................................... 16 mA
Updating time............................................... 135 ms
Load resistance............................................ < (Vsupply - 8) / 0.023 [Ω]
Load stability................................................ < ±0.01% of span/100 Ω

Sensor error detection:
Programmable.............................................. 3.5...23 mA
NAMUR NE43 Upscale................................ 23 mA
NAMUR NE43 Downscale............................ 3.5 mA

Of span = Of the presently selected range
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Ex appoval - 5343A:
KEMA 10ATEX0004 X...................................  II 3 GD Ex nA [nL] IIC T4...T6 or
  II 3 GD Ex nL IIC T4...T6 or
  II 3 GD Ex nA [ic] IIC T4...T6 or
  II 3 GD Ex ic IIC T6...T4
	 ATEX Installation Drawing No.................. 5343QA02

Ex / I.S. approval - 5343B:
KEMA 03ATEX1538......................................  II 1 G Ex ia IIC T4 or T6
  II 1 D Ex iaD
Max. amb. temperature for T4..................... 85°C
Max. amb. temperature for T6 .................... 60°C
ATEX, applicable in zone.............................. 0, 1, 2, 20, 21 or 22
	 ATEX Installation Drawing No.................. 5343QA01
Marine approval:
Det Norske Veritas, Ships & Offshore.......... Standard for Certification No. 2.4
GOST R approval:
VNIIM & VNIIFTRI, Cert. no.......................... See www.prelectronics.com
Observed authority requirements:  Standard:
EMC 2004/108/EC....................................... EN 61326-1
ATEX 94/9/EC............................................... EN 60079-0, EN 60079-11, 
	 EN 60079-15 and EN 60079-26 
	 EN 61241-0 and EN 61241-11
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Connections

1 2 

m A - + 

3 4 6 3 4 6 3 4 6 

Output: 
2-wire installation 

Input: 
Resistance, 2-wire Resistance, 3-wire 

Potentiometer, 
3-wire 
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Block diagram
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Programming
•	 Loop Link ia a communications interface that is needed for programming 

PRelevel 5343.

•	 For programming please refer to the drawing below and the help function in 
the PRelevel software.

•	 Loop Link is not approved for communication with modules installed in 
hazardous (Ex) areas.

Order: Loop Link

Mechanical specifications	M ounting of sensor wires

1 

2 

*

*

Loop
Link

5909 - USB
5905 - RS232

File  Product  Input  Output  Communication  Language  Option  08:30:00

PRetop 5331

Date: 2004-8-10

043201594

PRelectronics

Analog input
Analog output

Serial no:

Input type:
Output type: 4 - 20mA

Upscale
Sensor error:

Pt100  DIN/IEC

0.00 - 50.00 C

3-wire

1.00 sec
------

Input range:

Connection:

Cold junction comp:

Response time:

Tag no:

PRetop 5343 

Receiving 

Equipment Disconnect 

+Vsupply 

Black 

Red Yellow 

Green 

Input 

* Connected only for  
‘on-line" programming 

Connector 

Loop Link 

COM 

Wires must be mounted between the metal 
plates.
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Configuration of potentiometer input
In an Ohmic level sensor the resistance value changes when a magnetic floater 

activates the reed contacts in the sensor. This means that it is usually not 
possible to make use of the entire level sensor as input span. When PR5343 
is used with a potentiometer input, the PRelevel software contains the 
following special functions for configuration:

[Calibration Password] is 4711. This password should be entered at program 
start. The only parameters which can be changed without entering this 
password are Input Low and High for the potentiometer input. The menu item 
is located under Tools > Options. Please pay special attention to the text 
in the  ’Information’ window during transmission. When the configuration 
cannot be sent to the transmitter due to lack of password, the following 
text will appear: ’Operation aborted.’ ’Configuration NOT transmitted to the 
device.’

The following description of configuration with potentiometer input is based on 
figure 1. Please note that the PRelevel software only comes in an English-
language version. Therefore the menu texts are represented here as they are 
seen on the screen. First choose the [Input] tab:

Figure 1, cross section of horizontal cylindrical tank
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[Electrical Calibration] Enter the range to be detected by the connected 
potentiometer or let PRelevel measure the available range. The transmitter 
must be connected to the communications interface before the values can be 
measured. The values in figure 1 are Low = 3% og High = 97%.

[Placement Calibration] Enter the placement of the ’Electrical Calibration’ Low 
and High points of the level sensor in relation to the height of the tank. These 
values are used for calculation of linearisation values and for calculation of 0 
and 100% height. 
The values in figure 1 are Low = 9% and High = 94%.

[Input] Enter the desired input span in relation to the height. When input Low 
and High are selected as 0 and 100%, the input can never go below 9% and 
above 94% due to the design and mounting of the level sensor. If the output 
span is 4...20 mA, the output will only vary between 5.44...19.04 mA. 
The values in figure 1 are Low = 0% and High = 100%.

Activation of embedded linearisations
The PRelevel software contains embedded linearisation functions for horizontal 

cylindrical tanks and spherical tanks. The linearisation functions can be 
activated as follows:

Custom input type: In order to gain access to a customer-defined linearisation, 
the selection in the [General Type] input box must end with the text ’Custom’ 
and the [Calibration Password] 4711 must be entered. 

Activation of linearisation: Choose the [Options] tab in the PRelevel 5343 
window. If one of the embedded linearisations is to be used, the selection 
in the ’Linearisation’ window must be ’Polynomial.....(Relative)’ in order to 
retrieve the most accurate linearisation files. The files are retrieved by way 
of the following menus: >Specify + select >File > Open in the main menu + 
select >File name >Open in the file dialogue box. 

User-defined linearisation: It is possible to enter specific linearisation tables in 
the >Specify menu. 
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Transmetteur de niveau 2-fils 
PRelevel 5343
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Declaration de conformite CE
En tant que fabricant

PR electronics A/S 

Lerbakken 10 

DK-8410 Rønde

déclare que le produit suivant :

Type: 5343 

Nom: Transmetteur de niveau 2-fils

correspond aux directives et normes suivantes :

La directive CEM (EMC) 2004/108/CE et les modifications subséquentes

EN 61326-1 : 2006

	 Pour une spécification du niveau de rendement acceptable CEM (EMC)  
se référer aux spécifications électriques du module.

La directive ATEX 94/9/CE et les modifications subséquentes

EN 60079-0 : 2006, EN 60079-11 : 2007, 

EN 60079-15 : 2005 et EN 60079-26 : 2007 

EN 61241-0 : 2006 et EN 61241-11 : 2006 

Certificat ATEX : KEMA 10ATEX0004 X (5343A) 

Certificat ATEX : KEMA 03ATEX1538 (5343B)

Organisme notifié 

KEMA Quality B.V. (0344) 

Utrechtseweg 310, 6812 AR Arnhem 

P.O. Box 5185, 6802 ED Arnhem 

The Netherlands

Rønde, le 24 mars 2010 Kim Rasmussen 
 Signature du fabricant
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TRANSMETTEUR DE NIVEAU 2-FILS 
PRelevel 5343

• Entrée potentiométrique ou Ohmique 
• Sécurité programmable 
• Grande précision de mesure 
• Fonction d'étalonnage de process unique 
• Programmable depuis un PC

Application

•	 Conversion d'une résistance linéaire en un signal courant standard 
analogique pour mesurer par exemple le niveau ou la position d'une vanne.

•	 Fonction de linéarisation définie par l'utilisateur pouvant être activée.

Caractéristiques techniques

•	 Le PR5343 peut être programmé de manière simple et rapide.

•	 Vérification continue des données sauvegardées.

•	 Le transmetteur est protégé contre les inversions de polarité.

•	 PR5343 peut être configuré en fonction d'une application donnée à partir 
d'un PC, à l'aide du logiciel PRelevel et du kit de communication Loop Link.

•	 L’outil de configuration PRelevel, inclu dans le logiciel PReset, a été 
spécifiquement conçu pour la configuration des applications de niveau. 
Il contient entre autres une fonction pour la mesure en ligne de l'échelle 
d'entrée ainsi qu'une fonction de linéarisation pour une 
sortie linéaire du volume de cuves cylindriques horizontales.

Montage / installation

•	 Pour tête de sonde DIN B. En zone non-dangereuse le 5343 peut être monté 
sur rail DIN avec un support spécifique.

•	 N.B. : Comme barrière S.I. pour le 5343B nous recommandons le PR5104B, 
5114B ou 5116B.
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Applications
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Capteur de niveau 
résistif en 4...20 mA 

Installation 2-fils 
en salle de contrôle 

Potentiomètre 
en 4...20 mA 

Résistance en 4...20 mA 

Installation 2-fils 
en salle de contrôle 

Installation 2-fils 
en salle de contrôle 



	 5343V103-IN	 29

Spécifications
Plage de température :
-40°C à +85°C
Spécifications communes :
Tension d'alimentation cc
	 Standard.................................................. 8,0...35 V
	 ATEX Ex.................................................... 8,0...30 V
Consommation interne................................. 25 mW...0,8 W
Chute de tension.......................................... 8 Vcc
Temps de chauffe......................................... 5 min.
Kit de programmation.................................. Loop Link
Rapport signal / bruit................................... Min. 60 dB 
Temps de réponse (programmable)............. 0,33...60 s
Dynamique du signal d'entrée..................... 19 bit
Dynamique du signal de sortie.................... 16 bit
Température d'étalonnage........................... 20...28°C
Précision, la plus grande des valeurs générales et de base :

Valeurs générales

Type 
d'entrée

Précision 
absolue

Coefficient de 
température

R lin. ≤ ±0,1% de l'EC ≤ ±0,01% de l'EC / °C 

Immunité CEM................................................. < ±0,5% de l'EC

Valeurs de base

Type 
d'entrée

Précision 
de base

Coefficient de 
température

R lin. ≤ ±0,05 Ω ≤ ±0,002 Ω / °C

Référence : 5343

Type Version

5343 Standard	 : A 
ATEX Ex	 : B 



30	 5343V103-IN

Effet d'une variation de 
la tension d'alimentation.............................. < 0,005% de l'EC / Vcc
Vibration....................................................... IEC 60068-2-6 Test FC
Lloyd, spécification no 1.............................. 4 g / 2...100 Hz
Taille max. des fils........................................ 1 x 1,5 mm2 fil multibrins
Humidité....................................................... < 95% HR (sans cond.)
Dimensions................................................... Ø 44 x 20,2 mm
Degré de protection (boîtier / bornier)......... IP68 / IP00
Poids............................................................ 50 g

Spécifications électriques, entrée :

Entrée résistance linéaire :
Gamme de mesure....................................... 0...100 kΩ
Plage de mesure min. (EC)........................... 1 kΩ
Décalage max.............................................. 50% de la valeur max. sélectionnée
Résistance de ligne max. par fil................... 100 Ω
Courant de sonde........................................ > 25 µA, < 120 µA
Effet de la résistance de ligne (3-fils)........... < 0,002 Ω / Ω
Détection de rupture sonde......................... Oui

Sortie :

Sortie courant :
Gamme de signal......................................... 4...20 mA
Plage de signal min...................................... 16 mA
Temps de scrutation..................................... 135 ms
Résistance de charge................................... < (Valimentation - 8) / 0,023 [Ω]
Stabilité de charge....................................... < ±0,01% de l'EC/100 Ω

Détection de rupture sonde :
Programmable.............................................. 3,5...23 mA
NAMUR NE43 Haut d'échelle...................... 23 mA
NAMUR NE43 Bas d'échelle........................ 3,5 mA

EC = Echelle configurée
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Approbation Ex - 5343A :
KEMA 10ATEX0004 X...................................  II 3 GD Ex nA [nL] IIC T4...T6 ou
  II 3 GD Ex nL IIC T4...T6 ou
  II 3 GD Ex nA [ic] IIC T4...T6 ou
  II 3 GD Ex ic IIC T4...T6
	 ATEX Installation Drawing No.................. 5343QA02
Approbation Ex / S.I. - 5343B :
KEMA 03ATEX1538......................................  II 1 G Ex ia IIC T4 ou T6
  II 1 D Ex iaD
Température amb. max. (T4)........................ 85°C
Température amb. max. (T6)........................ 60°C
ATEX, applicable en zone............................. 0, 1, 2, 20, 21 ou 22
	 ATEX Installation Drawing No.................. 5343QA01
Approbation marine :
Det Norske Veritas, Ships & Offshore.......... Standard for Certification No. 2.4
Approbation GOST R :
VNIIM & VNIIFTRI, Cert. no.......................... Voir www.prelectronics.fr
Agréments et homologations : Standard :
EMC 2004/108/CE....................................... EN 61326-1
ATEX 94/9/CE............................................... EN 60079-0, EN 60079-11, 
	 EN 60079-15 et EN 60079-26 
	 EN 61241-0 et EN 61241-11
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Connexions

1 2 

m A - + 

3 4 6 3 4 6 3 4 6 

Sortie : 
Installation 2-fils 

Entrée : 
Résistance, 2-fils Résistance, 3-fils 

Potentiomètre, 
3-fils 
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Schema de principe
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Programmation
•	 Loop Link est un kit de programmation permettant de programmer le 

PRelevel 5343.

•	 Pour le raccordement de Loop Link, veuillez vous rapporter au schéma 
ci-dessous et à l'aide en ligne du logiciel PRelevel.

•	 Loop Link ne doit pas être utilisé pour communication avec des modules 
installés en zone dangereuse.

Référence : Loop Link

Dimensions mécaniques	M ontage des fils du capteur

1 

2 

*

*

Loop
Link

5909 - USB
5905 - RS232

File  Product  Input  Output  Communication  Language  Option  08:30:00

PRetop 5331

Date: 2004-8-10

043201594

PRelectronics

Analog input
Analog output

Serial no:

Input type:
Output type: 4 - 20mA

Upscale
Sensor error:

Pt100  DIN/IEC

0.00 - 50.00 C

3-wire

1.00 sec
------

Input range:

Connection:

Cold junction comp:

Response time:

Tag no:

PRetop 5343 

API ou autres 

Débranché 

+Valim. 

Noir 

Rouge Jaune 

Verte 

Entrée 

* Connexion facultative 

Connecteur 

Loop Link 

COM 

Les fils doivent être montés entre les 
plaques métalliques.
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Configuration de l'entrée potentiométrique
Pour un capteur de niveau magnéto-résistif la résistance change lorsque 

les contacts Reed du capteur sont activés par un flotteur magnétique. 
Cela veut dire qu'il est souvent impossible d'utiliser la longueur totale 
du capteur comme échelle d'entrée. Quand le 5343 est utilisé avec une 
entrée potentiométrique, le logiciel PRelevel donne accès aux fonctions de 
linéarisation spécifiques suivantes :

Le mot de passe [Calibration Password] est 4711. Ce mot de passe doit 
être entré au début de la programmation. Les seuls paramètres pouvant 
être changés sans introduction du mot de passe sont l'entrée basse et 
haute (Input Low et High). Ce menu se trouve sous Tools > Options. Faire 
attention au texte dans la fenêtre ’Information’ pendant la transmission. Si 
une configuration ne peut pas être transmise au transmetteur à cause d'un 
mot de passe manquant, le texte suivant apparaîtra : ’Operation aborted.’ 
’Configuration NOT transmitted to the device’ (Opération interrompue. La 
configuration n'a pas été transmise au transmetteur).

La description de la configuration avec entrée potentiométrique est décrite 
dans la figure 1 ci-dessous. Noter que le logiciel PRelevel n'existe qu'en 
version anglaise. Les textes des menus sont donc représentés ici comme ils 
apparaissent sur l'écran. D'abord, choisir l'onglet [Input]:

Figure 1, coupe dans une cuve cylindrique horizontale
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[Electrical Calibration] Entrer la gamme du potentiomètre connecté ou 
laisser PRelevel mesurer la gamme d'entrée. Pour mesurer les valeurs, le 
transmetteur doit être connecté au kit de programmation Loop Link. 
Les valeurs de la figure 1 sont Low = 3% et High = 97%.

[Placement Calibration] Entrer l'emplacement des points Low et High du 
capteur de niveau, obtenus lors de la procédure ’Electrical Calibration’, par 
rapport à la hauteur de la cuve. Ces valeurs sont utilisées tant pour le calcul 
des valeurs de linéarisation que pour le calcul des hauteurs 0 et 100%. 
Les valeurs de la figure 1 sont Low = 9% et High = 94%.

[Input] Entrer l'échelle d'entrée désirée par rapport à la hauteur. Quand les 
entrées Low et High sont sélectionnées à 0 et 100%, l'entrée ne peut jamais 
déscendre au-dessous de 9% ou monter au-dessus de 94% à cause de la 
conception et l'installation du capteur. Si l'échelle de sortie est de 4...20 mA, 
la sortie ne variera qu'entre 5,44 et 19,04 mA. 
Les valeurs de la figure 1 sont Low = 0% et High = 100%.

Activation des linéarisations internes
Le logiciel PRelevel contient des fonctions de linéarisation pour les cuves 

cylindriques horizontales et les cuves sphériques. Les fonctions de 
linéarisation peuvent être activées comme suit :

Type d'entrée client : Pour accéder à une linéarisation client, le choix dans le 
menu [General Type] doit se terminer par le texte ’Custom’ et le mot de passe 
[Calibration Password] 4711 doit être entré. 

Activation d'une linéarisaton : Choisir l'onglet [Options] dans la fenêtre 
PRelevel 5343. Si l'une des linéarisations internes doit être utilisée, choisir  
'Polynomial.....(Relative)’ dans la fenêtre ’Linearisation’ pour récupérer les 
fichiers de linéarisation les plus précis. Les fichiers sont récupérés à l'aide 
des menus suivants : >Specify + choisir >File > Open dans le menu principal 
+ indiquer >Nom du fichier >Ouvrir dans la fenêtre de dialogue.

Linéarisation client : Possibilité d'entrer des tables de linéarisation spécifiques 
dans le menu >Specify. 
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2-Draht Niveaumessumformer 

PRelevel 5343
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EG-Konformitätserklärung
Als Hersteller bescheinigt

PR electronics A/S 

Lerbakken 10 

DK-8410 Rønde

hiermit für das folgende Produkt:

Typ: 5343 

Name: 2-Draht Niveaumessumformer

die Konformität mit folgenden Richtlinien und Normen:

Die EMV Richtlinien 2004/108/EG und nachfolgende Änderungen

EN 61326-1 : 2006

	 Zur Spezifikation des zulässigen Erfüllungsgrades, siehe die Elektrische 
Daten des Moduls.

Die ATEX Richtlinien 94/9/EG und nachfolgende Änderungen

EN 60079-0 : 2006, EN 60079-11 : 2007, 

EN 60079-15 : 2005 und EN 60079-26 : 2007 

EN 61241-0 : 2006 und EN 61241-11 : 2006 

ATEX-Zertifikat: KEMA 10ATEX0004 X (5343A) 

ATEX-Zertifikat: KEMA 03ATEX1538 (5343B)

Zulassungsstelle

KEMA Quality B.V. (0344) 

Utrechtseweg 310, 6812 AR Arnhem 

P.O. Box 5185, 6802 ED Arnhem 

The Netherlands

Rønde, 24. März 2010 Kim Rasmussen 
 Unterschrift des Herstellers
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2-DRAHT NIVEAUMESSUMFORMER 
PRelevel 5343

• Eingang für Potentiometer oder Ohm 
• Programmierbare Fühlerfehleranzeige 
• Hohe Messgenauigkeit 
• Einzigartige Prozess-Kalibrierfunktion 
• Programmierbar über PC

Verwendung

•	 Umwandlung von linearer Widerstandsänderung in ein analoges Standard-
Stromsignal, z.B. von Ventilen oder Niveau-Messwertgeber.

•	 Anwenderdefinierte Linearisierungsfunktion kann aktiviert werden.

Technische Merkmale

•	 PR5343 kann vom Benutzer innerhalb von wenigen Sekunden zur Messung 
aller angegebenen ohmsche Werte programmiert werden.

•	 Die gespeicherten Daten werden laufend kontrolliert.

•	 Der Messumformer ist gegen Verpolung geschützt.

•	 Der PR5343 wird für die jeweilige Aufgabe konfiguriert mittels PC, der 
PRelevel-Software und der Kommunikationsschnittstelle Loop Link.

•	 Das PRelevel Konfigurations-Tool, das in der PReset-Software integriert ist, 
wurde speziell für die Konfiguration von Füllstands-Applikationen entwickelt. 
Unter anderem enthält sie eine Funktion für die "Online"-Messung der 
Eingangsspanne als auch eine Linearisierungsfunktion für einen volumenpro-
portionalen Ausgang für horizontale zylindrische Tanks.

• Montage / Installation

•	 Für DIN Form B Sensorkopf Montage. Im sicheren Bereich kann der 5343 auf 
einer DIN-Schiene mittels einer spezieller Armatur montiert werden. 

•	 NB: Als Ex-Sicherheitsbarriere für 5343B empfehlen wir 5104B, 5114B oder 
5116B.
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Anwendungen

+
-

+
-

V+

mA

V+

mA

+
-

V+

mA

Ohmsche Füllstands-
sensor in 4...20 mA

2-Draht-Installation
im Kontrollraum

Potentiometer
in 4...20 mA

Widerstand in 4...20 mA

2-Draht-Installation
im Kontrollraum

2-Draht-Installation
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Elektrische Daten
Spezifikationsbereich:
-40°C bis +85°C
Allgemeine Daten:
Versorgungsspannung, DC
	 Standard.................................................. 8,0...35 V
	 ATEX Ex.................................................... 8,0...30 V
Stromverbrauch............................................ 25 mW...0,8 W
Spannungsabfall........................................... 8 VDC
Aufwärmzeit.................................................. 5 min.
Kommunikationsschnittstelle....................... Loop Link
Signal- / Rauschverhältnis........................... Min. 60 dB 
Ansprechzeit (programmierbar).................... 0,33...60 s
Signaldynamik, Eingang............................... 19 Bit
Signaldynamik, Ausgang.............................. 16 Bit
Kalibrierungstemperatur............................... 20...28°C
Genauigkeit, höherer Wert von allgemeinen und Grundwerten:

Allgemeine Werte

 
Eingangsart

Absolute 
Genauigkeit

Temperatur- 
koeffizient

Lin. R ≤ ±0,1% d. Messsp. ≤ ±0,01% d. Messsp. / °C 

EMV Störspannungseinfluss........................... < ±0,5% d. Messsp.

Grundwerte

 
Eingangsart

Grund- 
Genauigkeit

Temperatur- 
koeffizient

Lin. R ≤ ±0,05 Ω ≤ ±0,002 Ω / °C

Bestellangabne: 5343

Typ Version

5343 Standard	 : A 
ATEX Ex	 : B 



42	 5343V103-IN

Einfluss von Änderung der 
Versorgungsspannung.................................. < 0,005% d. Messsp. / VDC
Vibration....................................................... IEC 60068-2-6 Test FC
Lloyd’s Spezifikation Nr. 1............................ 4 g / 2...100 Hz
Max. Leitungsquerschnitt............................. 1 x 1,5 mm2 Litzendraht
Luftfeuchtigkeit............................................. < 95% RH (nicht kond.)
Maß.............................................................. Ø 44 x 20,2 mm
Schutzart (Gehäuse / Klemmen).................. IP68 / IP00
Gewicht........................................................ 50 g

Elektrische Daten, Eingang:

Linearer Widerstandseingang:
Messbereich................................................. 0...100 kΩ
Min. Messbereich (Spanne).......................... 1 kΩ
Max. Nullpunktverschiebung (Offset)........... 50% d. gew. Maximalwertes
Leitungswiderstand pro Leiter (Max.)........... 100 Ω
Fühlerstrom..................................................> 25 µA, < 120 µA
Wirkung des Fühlerkabelwiderstandes 
(3-Leiter)....................................................... < 0,002 Ω / Ω
Fühlerfehlererkennung.................................. Ja

Ausgang:

Stromausgang:
Signalbereich................................................ 4...20 mA
Min. Signalbereich........................................ 16 mA
Aktualisierungszeit....................................... 135 ms
Belastungswiderstand..................................< (VVersorg.- 8) / 0,023 [Ω]
Belastungsstabilität...................................... < ±0,01% d. Messsp./100 Ω

Fühlerfehlererkennung:
Programmierbar........................................... 3,5...23 mA
NAMUR NE43 aufsteuernd.......................... 23 mA
NAMUR NE43 zusteuernd........................... 3,5 mA

d. Messsp. = der gewählten Messspanne



	 5343V103-IN	 43

Ex-Zulassung 5343A:
KEMA 10ATEX0004 X...................................  II 3 GD Ex nA [nL] IIC T4...T6 oder
  II 3 GD Ex nL IIC T4...T6 oder
  II 3 GD Ex nA [ic] IIC T4...T6 oder
  II 3 GD Ex ic IIC T4...T6
	 ATEX Installation Drawing No.................. 5343QA02
Ex- / I.S.-Zulassung - 5343B:
KEMA 03ATEX1538......................................  II 1 G Ex ia IIC T4 oder T6
  II 1 D Ex iaD
Max. Umgebungstemp. für T4..................... 85°C
Max. Umgebungstemp. für T6..................... 60°C
ATEX, für Anwendung in Zone..................... 0, 1, 2, 20, 21 oder 22
	 ATEX Installation Drawing No.................. 5343QA01
Marine-Zulassung:
Det Norske Veritas, Ships & Offshore.......... Standard for Certification No. 2.4
GOST R Zulassung:
VNIIM & VNIIFTRI, Cert. no.......................... Siehe www.prelectronics.de
Eingehaltene Richtlinien: Norm:
EMV 2004/108/EG........................................ EN 61326-1
ATEX 94/9/EG............................................... EN 60079-0, EN 60079-11, 
	 EN 60079-15 und EN 60079-26 
	 EN 61241-0 und EN 61241-11
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Anschlüsse

1 2 

m A - + 

3 4 6 3 4 6 3 4 6 

Ausgang: 
2-Draht-Installation 

Eingang: 
Widerst., 2-Leiter Widerst., 3-Leiter 

Potentiometer, 
3-Leiter 



	 5343V103-IN	 45

Blockdiagramm
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Programmierung
•	 Loop Link ist eine batteriegespeiste Schnittstelle zur Programmierung des 

PRelevel 5343.

•	 Bezüglich Programmierung verweisen wir auf die nachfolgende Zeichnung 
und die "Hilfe"-Funktion im PRelevel-Programm.

•	 Loop Link darf nicht zur Kommunikation mit Modulen, die in Ex-gefährdeten 
Bereichen installiert sind, benutzt werden.

Bestellangaben: Loop Link

Abmessungen	M ontage von Fühlerleitungen

1 

2 

*

*

Loop
Link

5909 - USB
5905 - RS232

File  Product  Input  Output  Communication  Language  Option  08:30:00

PRetop 5331

Date: 2004-8-10

043201594

PRelectronics

Analog input
Analog output

Serial no:

Input type:
Output type: 4 - 20mA

Upscale
Sensor error:

Pt100  DIN/IEC

0.00 - 50.00 C

3-wire

1.00 sec
------

Input range:

Connection:

Cold junction comp:

Response time:

Tag no:

PRetop 5343 

Betriebs- 
spannung 

Unterbrechen 

+VB 

Schwarz 

Rot Gelb 

Grün 

Eingang 

* Nur anzuschliessen, wenn on-line 
   (im Betrieb) konfiguriert werden soll 

Anschlussstelle

Loop Link 

COM 

Die Leitungen müssen zwischen den 
Metallplatten montiert werden.
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Konfiguration des Potentiometer-
Eingangs

Bei einem ohmschen Füllstandssensor ändert sich der Widerstandswert, wenn 
der magnetische Schwimmkörper die Reed-Kontakte im Sensor aktiviert. Das 
bedeutet, dass es üblicherweise nicht möglich ist, den ganzen Füllstandssen-
sor als Eingangsspanne zu verwenden. Wenn der PR5343 mit einem Poten-
tiometereingang verwendet wird, enthält die PRelevel-Software die folgenden 
speziellen Konfigurationsfunktionen:

Das [Calibration Password] (=Kalibrier-Passwort) lautet 4711. Dieses Passwort 
ist bei Programmstart einzugeben. Die einzigen Parameter, die ohne Eingabe 
des Passworts geändert werden können, sind oberer und unterer Grenzwert 
für den Potentiometereingang (Input Low und Input High). Der Menüpunkt 
befindet sich unter Tools > Options. Bitte achten Sie während der Über-
tragung besonders auf die Textausgabe im ’Information’-Fenster. Wenn die 
Konfiguration wegen fehlendem Passwort nicht an den Messumformer gesen-
det werden kann, erscheint der folgende Text: ’Operation aborted’, ’Configu-
ration NOT transmitted to the device’ (Operation abgebrochen, Konfiguration 
NICHT zum Gerät übertragen).

Abbildung 1, Querschnitt durch einen horizontalen zylindrischen Tank
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Die folgende Beschreibung der Konfiguration mit einem Potentiometereingang 
beruht auf Abbildung 1. Beachten Sie bitte, dass die PRelevel-Software nur 
in der englischsprachigen Version vorliegt. Die Menütexte sind daher hier so 
angegeben, wie sie auf dem Bildschirm erscheinen. Wählen Sie zunächst die 
Registerkarte [Input]:

[Electrical Calibration] Geben Sie den Bereich, der vom angeschlossenen 
Potentiometer erkannt werden soll, ein oder lassen Sie PRelevel den verfüg-
baren Bereich messen. Der Messumformer muss an die Kommunikations-
schnittstelle angeschlossen werden, bevor die Werte gemessen werden kön-
nen. Die Werte gemäß Abbildung 1 sind ’Low’ = 3% und ’High’ = 97%.

[Placement Calibration] Geben Sie die Positionen der ’Low’- und ’High’-Punkte
der elektrischen Kalibrierung des Füllstandssensors im Verhältnis zur Höhe 
des Tanks ein. Diese Werte werden für die Berechnung der linearisierten Werte 
verwendet und für die Berechnung von 0% und 100% der Höhe. 
Die entsprechenden Werte in Abbildung 1 sind ’Low’ = 9% und ’High’ = 94%.

[Input] Geben Sie die gewünschte Eingangsspanne im Verhältnis zur Höhe ein. 
Wenn die Werte für ’Low’ und ’High’ zu 0% bzw. 100% gewählt werden, kann 
der Eingangswert aufgrund der Geometrie und der Montage des Füllstands-
sensors nie unter 9% oder über 94% gehen; der Ausgangswert verändert 
sich dann demgemäß nur zwischen 5,44 und 19,04 mA. 
Die Werte in Abbildung 1 sind ’Low’ = 0% und ’High’ = 100%.

Aktivierung der eingebetteten 
Linearisierungsfunktionen

Die PRelevel-Software enthält eingebaute Linearisierungsfunktionen für horizon-
tale zylindrische und für sphärische Tanks. Die Linearisierungsfunktionen kön-
nen wie folgt aktiviert werden:

Kundenspezifischer Eingangstyp: Um Zugriff auf eine kundenspezifische Line-
arisierung zu erhalten, muss die Auswahl im Eingabefeld [General Type] mit 
dem Text ’Custom’ enden und das Kalibrierpasswort 4711 ist in Eingabefeld 
[Calibration Password] einzugeben.

Aktivierung der Linearisierung: Wählen Sie im Programmfenster von PRelevel 
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5343 die Karteikarte [Options]. Wenn eine der eingebetteten Linearisierungs-
funktionen verwendet werden soll, ist im Fenster ’Linearisation’ die Auswahl 
’Polynomial.....(Relative)’ zu treffen, um die geeignetsten Linearisierungsda-
teien auszuwählen. Die Dateien werden in den folgenden Menüs gewählt: Im 
Hauptmenü >Specify wählen, dann >File und >Open; danach in der Datei
auswahlbox den Dateinamen auswählen und auf >Open klicken.

Kundenspezifische Linearisierung: Im >Specify-Menü ist es möglich, spezielle 
kundenspezifische Linearisierungstabellen einzugeben.
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Appendix

ATEX Installation Drawings - 5343A 
UK, FR, DE, DK

ATEX Installation Drawings - 5343B 
UK, FR, DE, DK
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ATEX Installation drawing 
 
For safe installation of 5343A the following must be observed. The module shall only be installed 
by qualified personnel who are familiar with the national and international laws, directives and 
standards that apply to this area.  
Year of manufacture can be taken from the first two digits in the serial number. 

 
 
 

ATEX Certificate KEMA 10ATEX 0004X 
 
Marking 
 
 
 
 
 
 
Standards EN 60079-0 : 2006, EN 60079-11 : 2007, EN 60079-15 : 2005 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Special conditions for safe use: 
 
For use in a potentially explosive atmosphere of flammable gasses, vapours or mists, the 
transmitter shall be mounted in an enclosure providing a degree of protection of at least IP54 in 
accordance to EN60529. 
 
 
For use in the presence of combustible dusts the transmitter shall be mounted in an enclosure 
providing a degree of protection of at least IP6X in accordance with o EN60529. The surface 
temperature of the enclosure shall be determined after installation of the transmitter. 
 
For an ambient temperature ≥ 60ºC, heat resistant cables shall be used with a rating of at least 20 
K above the ambient temperature. 

T4:  -40 ≤ Ta ≤ 85ºC 
T6:  -40 ≤ Ta ≤ 60ºC 

II 3 GD  Ex nA [nL] IIC T6..T4 
II 3 GD  Ex nL IIC T6..T4 
 
II 3 GD  Ex nA [ic] IIC T6..T4 
II 3 GD  Ex ic IIC T6..T4 

Terminal: 3,4,6 
Ex nA [nL] 
 
Uo:  27 V 
Io:   7.0 mA 
Po:  45 mW 
Lo:  35 mH 
Co:  90 nF 

Terminal: 1,2 
Ex nA 
 
U  ≤ 35 VDC 
I  =  4 - 20 mA 

Terminal: 1,2 
Ex nL or Ex ic 
 
Ui = 35 VDC 
Li  = 10 μH 
Ci = 1.0 nF 
 

ATEX Installation Drawings, UK, FR, DE, DK - 5343A
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Schéma d’installation ATEX 
 
Pour une installation sûre du 5343A vous devez observer ce qui suit. Le module sera seulement 
installé par un personnel qualifié qui est informé des lois, des directives et des normes nationales et 
internationales qui s'appliquent à ce secteur. 
L'année de la fabrication est indiquée dans les deux premiers chiffres dans le numéro de série. 
 
 
Certificat ATEX KEMA 10ATEX 0004X 
 
Marquage 
 
 
 
 
 
 
Standards EN 60079-0 : 2006, EN 60079-11 : 2007, EN 60079-15 : 2005 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Conditions spécifiques à l’utilisation sûre : 
 
Pour utilisation dans les atmosphères potentiellement explosibles dû à la présence de gaz, vapeurs 
ou brumes inflammables, le transmetteur doit être installé dans un boîtier de protection assurant un 
degré d’étanchéité d’au moins IP54 conformément à l’EN 60529. 
 
Pour utilisation dans la présence de poussières combustibles, le transmetteur doit être installé dans 
un boîtier de protection assurant un degré d’étanchéité d’au moins IP6X conformément à l’EN 
60529. La température de surface du boîtier doit être déterminée après l’installation des unités. 
 
Pour une température ambiante ≥60°C, il faut utiliser des câbles résistant aux températures 
élevées avec une capacité nominale d’au moins 20 K au dessus de la température ambiante. 

T4:  -40 ≤ Ta ≤ 85ºC 
T6:  -40 ≤ Ta ≤ 60ºC 

II 3 GD  Ex nA [nL] IIC T6..T4 
II 3 GD  Ex nL IIC T6..T4 
 
II 3 GD  Ex nA [ic] IIC T6..T4 
II 3 GD  Ex ic IIC T6..T4 

Bornes : 3,4,6 
Ex nA [nL] 
 
Uo:  27 V 
Io:   7,0 mA 
Po:  45 mW 
Lo:  35 mH 
Co:  90 nF 

Bornes : 1,2 
Ex nA 
 
U  ≤ 35 Vcc 
I  =  4 - 20 mA 

Bornes : 1,2 
Ex nL ou Ex ic 
 
Ui = 35 Vcc 
Li  = 10 μH 
Ci = 1,0 nF 
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ATEX Installationszeichnung 
 
Für die sichere Installation von 5343A ist Folgendes zu beachten: Das Gerät darf nur von 
qualifiziertem Personal eingebaut werden, das mit den nationalen und internationalen Gesetzen, 
Richtlinien und Standards auf diesem Gebiet vertraut ist. 
Das Baujahr kann aus den ersten beiden Ziffern der Seriennummer ersehen werden. 
 
 
 
ATEX-Zertifikat KEMA 10ATEX 0004X 
 
Markierung 
 
 
 
 
 
 
Richtlinien EN 60079-0 : 2006, EN 60079-11 : 2007, EN 60079-15 : 2005 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Sonderbedingungen für sichere Anwendung: 
 
Für Anwendung in einer potentiellen explosiven Atmosphäre - basierend auf entflammbaren Gas, 
Dämpfen, Nebeln - muss der Messumformer in einem Gehäuse, welcher einen Schutzgrad von 
mindestens IP 54 gemäß EN 60529 besitzt, eingebaut werden. 
 
Für Anwendung in die Präsenz von entflammbaren Staub, muss der Messumformer in einem 
Gehäuse, welcher einen Schutzgrad von mindestens IP 6X gemäß EN 60529 besitzt, eingebaut 
werden. Die Oberflächentemperatur des Gehäuses muss nach der Installation der Einheiten 
festgestellt werden. 
 
Bei einer Umgebungstemperatur ≥60°C müssen hitzebeständige Leitungen eingesetzt werden, 
welche für eine mindestens 20 K höhere Umgebungstemperatur zugelassen sind. 

T4:  -40 ≤ Ta ≤ 85ºC 
T6:  -40 ≤ Ta ≤ 60ºC 

II 3 GD  Ex nA [nL] IIC T6..T4 
II 3 GD  Ex nL IIC T6..T4 
 
II 3 GD  Ex nA [ic] IIC T6..T4 
II 3 GD  Ex ic IIC T6..T4 

Klemme: 3,4,6 
Ex nA [nL] 
 
Uo:  27 V 
Io:   7,0 mA 
Po:  45 mW 
Lo:  35 mH 
Co:  90 nF 

Klemme: 1,2 
Ex nA 
 
U  ≤ 35 VDC 
I  =  4 - 20 mA 

Klemme: 1,2 
Ex nL oder Ex ic 
 
Ui = 35 VDC 
Li  = 10 μH 
Ci = 1,0 nF 
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ATEX Installationstegning 
 
For sikker installation af 5343A skal følgende overholdes: Modulet må kun installeres af 
kvalificerede personer, som er bekendt med national og international lovgivning, direktiver og 
standarder i det land, hvor modulet skal installeres. 
Produktionsår fremgår af de to første cifre i serienummeret. 
 
 
 
ATEX-certifikat KEMA 10ATEX 0004X 
 
Mærkning 
 
 
 
 
 
 
Standarder EN 60079-0 : 2006, EN 60079-11 : 2007, EN 60079-15 : 2005 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Særlige betingelser for sikker anvendelse: 
 
Ved installationer i eksplosive atmosfærer forårsaget af gasser, dampe eller tåger, skal 
transmitteren monteres i et hus med en tæthedsgrad på mindst IP54 i overensstemmelse med EN 
60529. 
 
Ved installationer i områder med potentiel eksplosionsfare på grund af brændbart støv, skal 
transmitteren monteres i et hus med en tæthedsgrad på mindst IP6X i overensstemmelse med EN 
60529. Husets overfladetemperatur bestemmes efter installation af enhederne. 
 
Hvis omgivelsestemperaturen ≥ 60°C, skal der bruges varmebestandige kabler med specifikationer 
på mindst 20K over omgivelsestemperaturen. 
 

T4:  -40 ≤ Ta ≤ 85ºC 
T6:  -40 ≤ Ta ≤ 60ºC 

II 3 GD  Ex nA [nL] IIC T6..T4 
II 3 GD  Ex nL IIC T6..T4 
 
II 3 GD  Ex nA [ic] IIC T6..T4 
II 3 GD  Ex ic IIC T6..T4 

Klemme: 3,4,6 
Ex nA [nL] 
 
Uo:  27 V 
Io:   7,0 mA 
Po:  45 mW 
Lo:  35 mH 
Co:  90 nF 

Klemme: 1,2 
Ex nA 
 
U  ≤ 35 VDC 
I  =  4 - 20 mA 

Klemme: 1,2 
Ex nL eller Ex ic 
 
Ui = 35 VDC 
Li  = 10 μH 
Ci = 1,0 nF 
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ATEX Installation drawing 
5343 
For safe installation of 5343B the following must be observed. The module shall only be installed by 
qualified personnel who are familiar with the national and international laws, directives and 
standards that apply to this area.  
Year of manufacture can be taken from the first two digits in the serial number. 

 
 
 

ATEX Certificate KEMA 03ATEX 1538 
 
Marking 
 
 
 
 
Standards EN 60079-0 : 2006, EN 60079-11 : 2007, EN 60079-26 : 2007,  
 EN 61241-0 : 2006, EN 61241-11 : 2006 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 

 
 
 
 
 
 
 

Non Hazardous Area 
Hazardous area 
Zone 0, 1, 2, 20, 21, 22 

 
 

II 1 G  Ex ia IIC T6..T4 
II 1 D  Ex iaD  

Terminal: 3,4,6 
Uo: 27 VDC 
Io:   7 mA 
Po:  45 mW 
Lo:  35 mH 
Co: 90 nF 

Terminal: 1,2 
Ui: 30 VDC 
Ii:   120 mA 
Pi:  0.84 W 
Li:  10μH 
Ci:  1.0nF 

1

2

6

5

4

3

+

-

Barrier

5343B

T4:  -40 ≤ Ta ≤ 85ºC  T105 ºC 
T6:  -40 ≤ Ta ≤ 60ºC  T80 ºC 

ATEX Installation Drawings, UK, FR, DE, DK - 5343B
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Installation notes. 

 
In a potentially explosive gas atmosphere, the transmitter shall be mounted in an enclosure in 
order to provide a degree of protection of at least IP20 according to EN60529. 
 
If the transmitter is installed in an explosive atmosphere requiring the use of equipment of 
category 1G and if the enclosure is made of aluminium, it must be installed such, that even in 
the event of rare incidents, ignition sources due to impact and friction, sparks are excluded; if 
the enclosure is made of non-metallic materials, electrostatic charging shall be avoided. 
 
For installation in a potentially explosive dust atmosphere, the following instructions apply: 
 
The transmitter shall be mounted in a metal enclosure form B according to DIN43729 that is 
providing a degree of protection of at least IP6X according to EN60529, that is suitable for the 
application and correctly installed. 
 
Cable entries and blanking elements shall be used that are suitable for the application and 
correctly installed. 
 
For an ambient temperature ≥ 60ºC, heat resistant cables shall be used with a rating of at least 
20 K above the ambient temperature. 
 
The surface temperature of the enclosure is equal to the ambient temperature plus 20 K, for a 
dust layer with a thickness up to 5 mm 



	 5343V103-IN	 57

 

5343QA01
LERBAKKEN 10, 8410 RØNDE DENMARK.       WWW.PRELECTRONICS.COM

 
 

   
Revision date: 

2009-09-22 
Version Revision 

V1R0 
 Page: 

1/2 
 

Schéma d’installation ATEX 
5343  
Pour une installation sûre du 5343B vous devez observer ce qui suit. Le module sera seulement 
installé par un personnel qualifié qui est informé des lois, des directives et des normes nationales et 
internationales qui s'appliquent à ce secteur. 
L'année de la fabrication est indiquée dans les deux premiers chiffres dans le numéro de série. 

 
 

 
 

Certificat ATEX        KEMA 03ATEX 1538 
 
Marquage 

 
 
    

 
 Standards EN 60079-0 : 2006, EN 60079-11 : 2007, EN 60079-26 : 2007,  
   EN 61241-0 : 2006, EN 61241-11 : 2006 
     

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 

Zone non dangereuse 
Zone dangereuse 
Zone 0, 1, 2, 20, 21, 22 

 
 

II 1 G  Ex ia IIC T6..T4 
II 1 D  Ex iaD  

Bornes: 3,4,6 
Uo: 27 VDC 
Io:   7 mA 
Po:  45 mW 
Lo:  35 mH 
Co: 90 nF 

Bornes: 1,2 
Ui: 30 VDC 
Ii:   120 mA 
Pi:  0,84 W 
Li:  10 μH 
Ci:  1,0 nF 

1

2

6

5

4

3

+

-

Barrier

5343B

T4:  -40 ≤ Ta ≤ 85ºC  T105 ºC 
T6:  -40 ≤ Ta ≤ 60ºC  T80 ºC 

Barrière



58	 5343V103-IN

 

5343QA01
LERBAKKEN 10, 8410 RØNDE DENMARK.       WWW.PRELECTRONICS.COM

 
 

   
Revision date: 

2009-09-22 
Version Revision 

V1R0 
 Page: 

2/2 
 

Notes d’installation: 
 

Dans les atmosphères potentiellement explosibles dû à la présence de gaz, le transmetteur doit 
être installé dans un boîtier de protection assurant un degré d’étanchéité d’au moins IP20 
conformément à l’EN 60529. 

 
Pour les installations dans les atmosphères explosibles exigeant des appareils de catégorie 1G, 
et dans le cas où le boîtier est fait d’aluminium, le boîtier doit être installé dans une telle manière 
que, même dans le cas d’incidents rares, les sources d’inflammation dûes aux impacts et aux 
étincelles de friction ne peuvent se produire; dans le cas où le boîtier est fait de matériaux non 
metalliques, les décharges électrostatiques sur le boîtier du transmetteur doivent être évitées. 

 
 

Pour les installations dans les atmosphères potentiellement explosibles dû à la présence de 
poussières combustibles on doit observer ce qui suit : 
 
Le transmetteur monté dans un boîtier métallique DIN B conformément à DIN 43729. Ce boîtier 
doit assurer un degré d’étanchéité d’au moins IP 6X conformément à l’EN 60529 et il doit 
convenir à l’application et être correctement installé. 

 
Seulement des raccords de câble et des bouchons convenant à l’application et correctement 
installés doivent être utilisés. 
 
Pour une température ambiante ≥60°C, il faut utiliser des câbles résistant aux températures 
élevées avec une capacité nominale d’au moins 20 K au dessus de la température ambiante. 
 
La température superficielle du boîtier égale la température ambiante plus 20K, pour une couche 
de poussière d’un épaisseur jusqu’à 5 mm. 
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ATEX Installationszeichnung 
5343 
Für die sichere Installation von 5343B ist Folgendes zu beachten: Das Gerät darf nur von 
qualifiziertem Personal eingebaut werden, das mit den nationalen und internationalen Gesetzen, 
Richtlinien und Standards auf diesem Gebiet vertraut ist. 
Das Baujahr kann aus den ersten beiden Ziffern der Seriennummer ersehen werden. 

 
 
 

ATEX-ZertifikatKEMA 03ATEX 1538 
 
Markierung 
 
 
 
 
Richtlinien EN 60079-0 : 2006, EN 60079-11 : 2007, EN 60079-26 : 2007,  
 EN 61241-0 : 2006, EN 61241-11 : 2006 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Nicht Ex-Bereich 
Ex-Bereich 
Zone 0, 1, 2, 20, 21, 22 

 
 

II 1 G  Ex ia IIC T6..T4 
II 1 D  Ex iaD  

Klemme: 3,4,6 
Uo: 27 VDC 
Io:   7 mA 
Po:  45 mW 
Lo:  35 mH 
Co: 90 nF 

Klemme: 1,2 
Ui: 30 VDC 
Ii:   120 mA 
Pi:  0,84 W 
Li:  10 μH 
Ci:  1,0 nF 

1

2

6

5

4

3

+

-

Barrier

5343B

T4:  -40 ≤ Ta ≤ 85ºC  T105 ºC 
T6:  -40 ≤ Ta ≤ 60ºC  T80 ºC 

Barriere
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Installationsvorschriften 
 
 
Für Anwendung in einer potentiellen explosiven Atmosphäre - basierend auf entflammbares 
Gas - muss der Messumformer in einem Gehäuse, welcher einen Schutzgrad von mindestens 
IP20 gemäß EN 60529 besitzt, eingebaut werden. 
 
Für Applikationen in explosiver Atmosphäre, wo Kategorie 1G Geräte vorgeschrieben sind, und 
wenn das Gehäuse aus Aluminium ist, ist das Gehäuse so zu montieren, dass Zündquellen 
(Stöße und Reibungsfunken) selbst bei selten auftretenden Störungen vermieden werden; 
wenn das Gehäuse aus nichtmetallischen Bestandteile ist, muss die elektrostatische Ladung 
der Gehäuse vermieden werden. 
 
 
Für Anwendung in einer potentiellen explosiven Atmosphäre - basierend auf entflammbaren 
Staub - ist Folgendes zu beachten: 
 
Der Messumformer muss in einem Metallkopf Form B gemäß DIN 43729 montiert werden. Das 
Gehäuse muss einen Schutzgrad von mindestens IP 6X gemäß EN 60529 besitzen und für 
den dementsprechenden Einsatz zugelassen werden. 
 
Es dürfen nur Kabeleinführungen und Abdeckungen eingesetzt werden, welche für die 
jeweilige Anwendung zugelassen sind. 
 
Bei einer Umgebungstemperatur ≥60°C müssen hitzebeständige Leitungen eingesetzt werden, 
welche für eine mindestens 20 K höhere Umgebungstemperatur zugelassen sind. 
 
Die Umgebungstemperatur der Gehäuse entspricht der Umgebungstemperatur plus 20K für 
eine Staubschicht mit einer Dicke von bis zu 5 mm. 
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ATEX Installationstegning 
5343  
For sikker installation af 5343B skal følgende overholdes: Modulet må kun installeres af 
kvalificerede personer, som er bekendt med national og international lovgivning, direktiver og 
standarder i det land, hvor modulet skal installeres. 
Produktionsår fremgår af de to første cifre i serienummeret 
 
 
ATEX-certifikat KEMA 03ATEX 1538 
 
Mærkning 
 
 
 
 
Standarder EN 60079-0 : 2006, EN 60079-11 : 2007, EN 60079-26 : 2007,  
 EN 61241-0 : 2006, EN 61241-11 : 2006 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 

 
 
 
 
 
 

Ikke Ex-område 
Ex-område 
Zone 0, 1, 2, 20, 21, 22 

 
 

II 1 G  Ex ia IIC T6..T4 
II 1 D  Ex iaD  

Klemme: 3,4,6 
Uo: 27 VDC 
Io:   7 mA 
Po:  45 mW 
Lo:  35 mH 
Co: 90 nF 

Klemme: 1,2 
Ui: 30 VDC 
Ii:   120 mA 
Pi:  0,84 W 
Li:  10 μH 
Ci:  1,0 nF 

1

2

6

5

4

3

+

-

Barrier

5343B

T4:  -40 ≤ Ta ≤ 85ºC  T105 ºC 
T6:  -40 ≤ Ta ≤ 60ºC  T80 ºC 
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Installationsforskrifter 
 
I områder med potential eksplosionsfare på grund af brændbar gas skal transmitteren 
installeres i et hus med en kapslingsklasse på mindst IP20 i overensstemmelse med EN60529. 
 
Hvis transmitteren installeres i eksplosive atmosfærer, hvor kategori 1G udstyr er krævet, og 
hvis huset er lavet af aluminium, skal det installeres således, at der selv ved sjældent 
opstående hændelser ikke er risiko for antændelse på grund af stød og friktionsgnister; hvis 
huset er lavet af ikke-metallisk materiale, skal elektrostatiske ladninger på transmitterens hus 
undgås. 
 
For installation i områder med potentiel eksplosionsfare på grund af brændbart støv skal 
følgende overholdes: 
 
Transmitteren skal monteres i et form B metalhus i overensstemmelse med DIN 43729. Huset 
skal have en tæthedsgrad på mindst IP 6X i overensstemmelse med EN 60529 og skal være 
egnet til den pågældende applikation samt være installeret korrekt. 
 
Der må kun anvendes kabelforskruninger og blindstik, som egner sig til den pågældende 
applikation og som installeres korrekt. 
 
Hvis omgivelsestemperaturen ≥ 60°C, skal der bruges varmebestandige kabler med 
specifikationer på mindst 20K over omgivelsestemperaturen. 
 
Husets overfladetemperatur er lig med den maksimale omgivelsestemperatur plus 20 K for 
støvlag med en tykkelse på op til 5 mm. 

 



Programmable displays with a wide se-
lection of inputs and outputs for display of temperature, 
volume and weight, etc. Feature linearisation, scaling, 
and difference measurement functions for programming 
via PReset software.

Displays

A wide selection of transmitters for DIN 
form B mounting and DIN rail modules with analogue 
and digital bus communication ranging from application- 
specific to universal transmitters.

Temperature

Galvanic isolators for analogue and digital 
signals as well as HART® signals. A wide product range 
with both loop-powered and universal isolators featuring 
linearisation, inversion, and scaling of output signals.

Isolation

Interfaces for analogue and digital 
signals as well as HART® signals between sensors / I/P
converters / frequency signals and control systems in Ex 
zone 0, 1 & 2 and for some modules in zone 20, 21 & 22.

Ex interfaces

PC or front programmable modules with 
universal options for input, output and supply. This range 
offers a number of advanced features such as process 
calibration, linearisation and auto-diagnosis.

Universal
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France
PR electronics Sarl
Zac du Chêne, Activillage
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PR electronics GmbH
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D-46149 Oberhausen
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PR electronics S.r.l.
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IT-20132 Milano
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PR electronics S.L.
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PR electronics AB
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PR electronics UK Ltd
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PR electronics Inc
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